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Intro duction

Welcome to Silicon Graphics Digital Audio sound production! 

The Silicon Graphics DA1100 Digital Audio Card (referred to as 
“Digital Audio Card” throughout this owner’s guide) is a 
multichannel digital audio I/O card that supports professional 
audio/video equipment through industry-standard interfaces. With 
your Digital Audio Card, you can capture and play back up to ten 
channels of true 24-bit digital audio. Your Digital Audio Card 
supports Microsoft’s industry-standard WAVE audio interface, and is 
compatible with all audio applications that support Windows 
Multimedia. You can use your Digital Audio Card’s professional 
video synchronization features to produce audio-for-video content on 
your Silicon Graphics 320 or Silicon Graphics 540 visual workstation.

Following is a description of each of the sections in this owner’s guide: 

• Chapter 1, “Installing the Digital Audio Card,” explains how to 
install your Digital Audio Card in the Silicon Graphics 320 and 
Silicon Graphics 540 visual workstations. 

• Chapter 2, “Using the Digital Audio Card Control Panels,” 
defines the Digital Audio and Digital Audio Meters control panel 
settings, and shows you how to set up ADAT and AES input and 
output signal paths and video sync sources. 

• Chapter 3, “Configuring the Digital Audio Card,” shows you 
how to set up your Digital Audio Card for video soundtrack 
production in a number of studio configurations, and how to 
configure WAVE audio devices.

• Appendix A lists the Digital Audio Card specifications.

• Appendix B lists the supported WAVE audio sample formats.

• The Glossary defines digital audio related terms used in this 
owner’s guide.
ix



Additional References

For related sources of information, refer to the following documents: 

• Silicon Graphics 320 Visual Workstation Owner’s Guide

• Silicon Graphics 540 Visual Workstation Owner’s Guide

• Digital Media Programming Guide for Silicon Graphics Visual 
Workstations 

• Audio/Video User’s Guide for Silicon Graphics 320 and Silicon 
Graphics 540 Visual Workstations

Note: You can also find some of the above documents and driver 
upgrades in the Silicon Graphics Supportfolio on the Web at: 
http://support.sgi.com/nt
x



Chapter 1

1. Installing the Digital Audio Card

This chapter shows you how to install your Digital Audio Card in the 
Silicon Graphics 320 and Silicon Graphics 540 visual workstations. 

Digital Audio Card Components

Your Digital Audio Card has one DB15 connector and two ADAT 
optical connectors (one input, one output), as shown in Figure 1-1. The 
card comes with one breakout cable, which connects to the DB15 
connector, two fiber optic cables, which connect to the ADAT 
connectors, and one video sync cable, which connects to an internal 
video sync connector on your workstation’s motherboard.

Figure 1-1 Digital Audio Card and Cables

Video sync
Breakout cable

Fiber optic
cables

DB15 connector

ADAT connectors

cable
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Installing the Digital Audio Card in the Silicon Graphics 320

Your Digital Audio Card is a 32-bit PCI card but you can install it in 
any of the three PCI slots in your Silicon Graphics 320. If you want to 
synchronize audio with video using the internal video sync feature in 
the Silicon Graphics 320, you must connect the card to the 
motherboard using the provided video sync cable. To install your 
Digital Audio Card, follow these steps:

1. Turn off the power to your system. 

2. Remove your workstation’s cover, as described in your Silicon 
Graphics 320 Owner’s Guide.

3. Unwrap your Digital Audio Card in a clean environment, and 
leave the dust protectors on the ADAT connectors until you 
attach the fiber optic cables.

The two ADAT optical connectors on the Digital Audio Card are 
highly sensitive to dust contamination. 

4. If you want to synchronize audio with video using a Silicon 
Graphics 320, follow these steps before inserting the Digital 
Audio Card in your system. If not, proceed to step 5.

■ Temporarily remove any other PCI cards installed in your 
system. 

This provides access to the internal video sync connector 
located near the bottom edge of the Silicon Graphics 320 
motherboard. 

■ Connect one end of the provided video sync cable to the 
internal video sync connector on your system’s motherboard, 
as shown in Figure 1-2.

After you connect the video sync cable to the motherboard, 
you can reinstall any other PCI cards.

■ Connect the other end of the video sync cable to the video 
sync connector on the outside edge of the Digital Audio 
Card.
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5. Insert your Digital Audio Card (firmly but gently) into a PCI slot 
in your workstation as shown in Figure 1-2. 

You should hear the card snap into place. Refer to your Silicon 
Graphics 320 Owner’s Guide for specific PCI card installation 
instructions.

Figure 1-2 Inserting the Digital Audio Card in the Silicon Graphics 320 
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Installing the Digital Audio Card in the Silicon Graphics 540

You can install your Digital Audio Card in any of the six PCI slots in 
your Silicon Graphics 540. There is a video sync connector next to each 
of the top five slots, as shown in Figure 1-3. You can use this connector 
to synchronize audio with video using your system’s internal video 
sync capability. To install your Digital Audio Card, follow these steps:

1. Turn off the power to your system. 

2. Remove your workstation’s cover, as described in your Silicon 
Graphics 540 Owner’s Guide.

3. Unwrap your Digital Audio Card in a clean environment, and 
leave the dust protectors on the ADAT connectors until you 
attach the fiber optic cables.

The two ADAT optical connectors on the Digital Audio Card are 
highly sensitive to dust contamination. 

4. If you want to synchronize audio with video using a Silicon 
Graphics 540, follow these steps. If not, proceed to step 5.

■ Connect one end of the provided video sync cable to the 
video sync connector below an empty PCI slot on your 
workstation’s motherboard, as shown in Figure 1-3.

■ Connect the loose end of the video sync cable to the video 
sync connector on the outside edge of the Digital Audio 
Card.
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5. Insert your Digital Audio Card (firmly but gently) into the 
appropriate PCI slot for your video sync connection.

You should hear the card snap into place. Refer to your Silicon 
Graphics 540 Owner’s Guide for specific PCI card installation 
instructions.

Figure 1-3 Inserting the Digital Audio Card in the Silicon Graphics 540
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Digital Audio Card Software

After installing the Digital Audio Card in your system, use the Digital 
Audio Installation CD to install the following files in your system:

• oemsetup.inf

The installation file

• sgirad.dll

The user level driver

• sgirad.sys

The kernel level driver

• sgiradmp.exe

The Digital Audio Meter Panel

• sgiradcp.exe

The Digital Audio Control Panel

• sgiradpi.dll

Library shared by sgiradcp.exe and sgiradmp.exe

• sgiradcp.cpl

The cpl file for the Digital Audio Control Panel

• sgiradmp.cpl

The cpl file for the Digital Audio Meter Panel

• Readme.rtf

The readme file containing the release notes
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Installing the Digital Audio Card Software

To install the Digital Audio Card software, follow these steps:

1. Insert the Digital Audio Installation CD.

2. Choose Start > Settings > Control Panel.

3. Double-click the Multimedia icon to open the Multimedia 
Properties control panel (shown in Figure 1-4 after installation).

4. Click the Devices tab in the Multimedia Properties control panel.

5. Click the Add button in the Devices window.

Make sure Unlisted or Updated Driver is selected in the list of 
drivers. 

6. Click OK in the Add dialog box.

An Install Driver dialog box appears. 

7. Enter the path for the Digital Audio Card driver files on your 
Digital Audio Installation CD. 

You can use the Browse button to locate your Installation CD 
containing the driver files, for example, E:

8. Click OK in the Install Driver dialog box.

An Add Unlisted or Updated Driver dialog box appears, 
displaying Silicon Graphics Digital Audio X.X (1.1 for the first 
release). 

9. Click OK in the Add Unlisted or Updated Driver dialog box.

Windows NT installs the Digital Audio software in your system 
folder and modifies the system registry as required.

The System Setting Change dialog box appears, which confirms 
that the SGI Digital Audio driver is installed in your system and 
tells you to restart.

10. Click Restart Now in the System Setting Change dialog box.

Your workstation restarts with the Digital Audio software 
installed.
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Upgrading the Digital Audio Card Software

Before installing a new version of the Digital Audio Card software, 
you have to remove the current driver and restart the system. To 
upgrade the Digital Audio Card software, follow these steps:

1. Choose Start > Settings > Control Panel.

2. Double-click the Multimedia icon to open the Multimedia 
Properties control panel, shown in Figure 1-4.

3. Click the Devices tab in the Multimedia Properties control panel.

4. Click the plus sign [+] next to the Audio Devices speaker icon to 
display the list of Audio drivers. 

5. Click Audio for SGI Digital Audio X.X (X.X = currently installed 
version of the driver, e.g., 1.1).

6. Click the Remove button at the bottom of the Devices window.

A dialog box asks if you want to remove the driver.

7. Click Yes in the dialog box.

The System Setting Change dialog box appears. 

8. Click Restart Now in the System Setting Change dialog box.

9. Follow the Digital Audio Card software installation procedures 
described in the previous section “Installing the Digital Audio 
Card Software.”

Windows NT looks for any earlier versions of the driver. 

A Driver Exists dialog box appears during the installation 
process and asks whether you want to use the current sgirad.dll 
driver or install a new driver.

10. Click New. 

A dialog box asks if you want to replace the currently installed 
versions of the Digital Audio files with the new versions. 

11. Click Yes to complete the installation.

Note:  You can download software upgrades from the Silicon 
Graphics Supportfolio on the Web at: 
http://support.sgi.com/nt
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Verifying the Digital Audio Card Software Installation

Follow these steps to verify successful installation of the Digital Audio 
Card software:

1. Choose Start > Settings > Control Panel.

2. Double-click the Multimedia icon to open the Multimedia 
Properties control panel, shown in Figure 1-4.

3. Click the Devices tab in the Multimedia Properties control panel.

4. Click the plus sign [+] next to the Audio Devices speaker icon.

A list of audio drivers installed in your system appears, and the 
Audio Devices speaker icon plus sign [+] changes to a minus sign 
[-], as shown in Figure 1-4. 

5. Verify that Audio for SGI Digital Audio X.X appears in the list 
(X.X = currently installed version of the driver, e.g., 1.1).

Figure 1-4 Multimedia Properties Control Panel - Digital Audio Driver 
Installed
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6. Click the Audio tab in the Multimedia Properties control panel, 
and then choose SGI Sound Playback in the Preferred device 
drop-down menu in the Playback area of the panel.

Five Digital Audio WAVE Playback devices should appear for 
each Digital Audio Card installed in your system, as shown in 
Figure 1-5 (you have to scroll through the list to display the 
WAVE playback devices for more than one card). 

You can select a device from this list to play audio through the 
different physical output channels on the Digital Audio Card.

Figure 1-5 WAVE Playback Devices
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7. Choose SGI Sound Record in the Preferred device drop-down 
menu in the Recording area of the panel

Five Digital Audio WAVE Recording devices should appear for 
each Digital Audio Card installed in your system, as shown in 
Figure 1-6 (you have to scroll through the list to display the 
WAVE recording devices for more than one card). 

You can select a device from this list to record audio from the 
different physical input channels on the Digital Audio Card.

For more information on WAVE devices, see “Configuring Wave 
Audio Devices” in Chapter 3.

Figure 1-6 WAVE Recording Devices
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8. Click the Silicon Graphics icon in the System Tray on the taskbar 
(near the clock).

The Silicon Graphics Control Panels Menu should appear, as 
shown in Figure 1-7. 

Figure 1-7 Silicon Graphics Control Panels Menu

9. Choose Digital Audio Control Panel.

The Digital Audio Control Panel should appear, as shown in the 
example in Figure 1-8 for a workstation with two Digital Audio 
Cards installed. You can also open this control panel by choosing 
Start > Settings > Control Panel > SGI Digital Audio Control.

In this control panel, you can set up your Digital Audio Card(s), 
as described in detail in Chapters 2 and 3.

Figure 1-8 Digital Audio Control Panel
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10. Choose Digital Audio Meter Panel.

The Digital Audio Meters panel should appear, as shown in the 
example in Figure 1-9 for a workstation with two Digital Audio 
Cards installed.

You can also open this control panel by choosing Start > Settings 
> Control Panel > SGI Digital Audio Meters.

In this control panel, you can monitor the audio signal levels on 
your Digital Audio Card(s), as described in detail in Chapter 2.

Figure 1-9 Silicon Graphics Digital Audio Meters Panel

If you verified the preceding steps 1 through 10, your Digital Audio 
Card software is successfully installed in your system.

If you cannot verify steps 1-10, make sure your Digital Audio Card is 
properly connected to a PCI slot inside your workstation.

If your Digital Audio Card is properly connected and you still cannot 
verify steps 1 through 10, reinstall the Digital Audio Card software.
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Identifying Digital Audio Cards after Installation

If you install more than one Digital Audio Card in your workstation, 
you can identify each card using the Digital Audio Control Panel. The 
control panel numbers the installed Digital Audio Cards either 1–3 for 
a Silicon Graphics 320 workstation, or 1–6 for a Silicon Graphics 540 
workstation.

Note: If only one Digital Audio Card is installed in your 
workstation, you can skip this section.

To identify a card, follow these steps and make sure you can see the 
back of your workstation:

1. Click the Silicon Graphics icon in the System Tray on the taskbar 
(near the clock).

2. Choose Digital Audio Control Panel. 

3. Choose one of the numbered Digital Audio Card tabs at the top 
of the Digital Audio Control Panel.

4. Click the Blink Optical Output button near the bottom of the 
Digital Audio Control Panel.
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A dialog box tells you the identification number of the selected 
Digital Audio Card, and that the blinking optical output line 
corresponds to that card, as shown in the example in Figure 1-10.

Figure 1-10 Digital Audio Card Identification

5. Look at the back of your workstation and determine which card 
has the blinking red light. 

The card with the blinking light corresponds to the numbered 
Digital Audio Card tab you selected in the Digital Audio Control 
Panel.

Note: To see the blinking light, you have to remove the dust 
caps on your Digital Audio Card’s ADAT optical output 
connectors.

6. Repeat the preceding steps for all Digital Audio Cards installed 
in your workstation.
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Connecting Cables to the Digital Audio Card

Your Digital Audio Card comes with three external cables—a breakout 
cable and two fiber optic cables. 

Note: The ADAT optical  connectors on the Digital Audio Card 
are highly sensitive to dust. Leave the dust covers on 
these connectors until you connect the fiber optic cables.

Connecting the Br eakout Cable

The breakout cable allows you to connect video input and output 
devices to your Digital Audio Card so you can synchronize sound 
with video. This cable includes the following connectors, as shown in 
Figure 1-11.

• A red coax digital input (AES/EBU)

• A blue coax digital output (AES/EBU)

• A black video reference loop-through

• A green video reference loop-through

Figure 1-11 Breakout Cable
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You connect the breakout cable to the DB15 connector on the Digital 
Audio Card, as shown in Figure 1-12. The breakout cable supports 
video synchronization and the AES-3id digital audio standard for 
transmitting AES/EBU digital audio over 75 ohm coaxial cable. The 
black and green video reference loop cables are interchangeable.

If you use only a video input and do not loop through to another 
device, terminate the unused video connector with a 75 ohm BNC 
terminator.

Figure 1-12 Connecting the Breakout Cable and ADAT Optical Cables

ADAT connectors

DB15 connector

Fiber optic cables

Breakout cable

In
Out
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Connecting the Fiber Optic Cables

The ADAT optical  connectors on your Digital Audio Card provide 
high bandwidth eight-channel digital audio fiber optic input and 
output. To attach the provided fiber optic cables to your Digital Audio 
Card, follow these steps:

1. Remove the dust caps from the ADAT optical connectors on your 
Digital Audio Card.

2. Connect one end of each fiber optic cable to each of the Digital 
Audio Card’s ADAT connectors, as shown in Figure 1-12.

3. Connect the other end of each fiber optic cable to an ADAT 
connector on an ADAT optical compatible device. 

Make sure you connect the output on a device to the input on the 
other device.

Note: Until you connect such a device, keep the dust caps on the 
Digital Audio Card’s ADAT optical connectors. You can 
also use one of the fiber optic cables as an alternative dust 
protector by connecting it to both ADAT connectors.

Some ADAT optical  compatible devices provide the option of 
clocking their inputs either externally or internally (internally is often 
the default). For proper output to such devices, you must configure 
external clocking. For external clocking configuration instructions, 
refer to the ADAT device’s manual.
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Connecting External Devices to the Breakout Cable
AES/EBU Connectors

If you want to connect the AES-3id input or output to an external 
AES/EBU device that uses 3 pin XLR connectors, you have to use 
balun (balanced/unbalanced) transformers to convert coax format to 
balanced XLR format, as shown in Figure 1-13. You should attach the 
balun transformers directly to the XLR connectors on the external 
device and run 75 ohm coaxial cable between the balun transformers 
and your Digital Audio Card.

Figure 1-13 Connecting Balun Transformers
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Chapter 2

2. Using the Digital Audio Card Control Panels

This chapter describes the Digital Audio Control Panel and Digital 
Audio Meters Panel. It defines each setting and shows you how to set 
up ADAT and AES input and output signal paths, video sync sources, 
and other Digital Audio Card parameters.

Digital Audio Control Panel

You use the Digital Audio Control Panel to set up your Digital Audio 
Card(s). 

1. Click the Silicon Graphics icon in the System Tray on the taskbar 
(near the clock). 

The Silicon Graphics Control Panels menu appears, as shown in 
Figure 2-1.

Figure 2-1 Silicon Graphics Control Panels Menu
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2. Choose Digital Audio Control Panel.

The Digital Audio Control Panel appears, as shown in Figure 2-2, 
for a workstation with two Digital Audio Cards installed.

You can also open the Digital Audio Control Panel by choosing 
Start > Settings > Control Panel > SGI Digital Audio Control.

Numbered tabs appear at the top of the control panel, which 
correspond to each Digital Audio Card installed in your system. 
If you have more than one card installed, you can select one of 
these tabs to display the control panel settings for the card you 
want to configure.

There is also an Internal Video Sync tab, which is described later 
in this chapter.

Figure 2-2 Silicon Graphics Digital Audio Control Panel
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3. Click File in the menu bar.

The File menu displays two options, Digital Audio Meters, 
which opens that panel and Exit which closes the Digital Audio 
Control Panel.

4. Click Help in the menu bar.

The Help menu displays two options, Contents, which displays 
the Silicon Graphics Audio/Video Help book, and About, which 
displays the version number of the currently installed Digital 
Audio software.

ADAT In

In the ADAT input section of the Digital Audio Control Panel, you can 
specify whether your Digital Audio Card uses an ADAT 8-channel 
optical input or an AES 2-channel optical input. This section of the 
control panel also displays the current sampling rate for the ADAT 
8-channel input. 

Input Source

The ADAT input source default setting is Optical. If you specify an 
AES optical input source, for example, using an S/PDIF 2-channel 
input, the ADAT input source is automatically set to None, as 
illustrated in Figure 2-3. 

Clock Source

The ADAT input always derives its clock from the corresponding 
input signal.
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Sampling Rate

The Sampling Rate field displays the current measured sampling rate 
for the ADAT input signal.

To activate a new ADAT Input Source and display its Sampling Rate, 
you must click the Apply button or the OK button at the bottom of the 
control panel. The OK button also closes the control panel.

Figure 2-3 ADAT and AES Input Signal Paths
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ADAT Out

In the ADAT output section of the Digital Audio Control Panel, you 
can specify the clock source and sampling rate for the ADAT 8-channel 
output.

Output Destination

The ADAT output destination default setting is Optical. If you specify 
an AES optical output source, for example, an S/PDIF 2-channel 
output, the ADAT output destination is automatically set to None and 
the ADAT Out channel is disabled, as illustrated in Figure 2-4.

Clock Source

You can choose any of the following clock sources for the ADAT 
output:

• AES Input

• ADAT Input

• Internal 44.1 kHz (oscillator)

• Internal 48 kHz (oscillator)

• Video Sync 44.1 kHz (derived from a reference video sync source)

• Video Sync 48 kHz (derived from a reference video sync source)

Use the Video Sync Source setting in the lower left corner of the 
control panel to specify whether the reference video clock is derived 
from the external video input on the Digital Audio Card or the internal 
video sync connection in your workstation. This setting is described in 
detail later in this chapter.
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Sampling Rate

If you choose AES input or ADAT input as the clock source, the 
Sampling Rate field displays the current measured sampling rate for 
the corresponding AES or ADAT output signal. If you choose an 
internal oscillator or a reference video sync source as the clock source, 
the Sampling Rate field displays the nominal sample rate (48.00 kHz 
or 44.10 kHz).

To activate a new ADAT Out Clock Source and Sampling Rate, you 
must click the Apply button or the OK button at the bottom of the 
control panel (OK also closes the window).

Figure 2-4 ADAT and AES Output Signal Paths
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AES In

In the AES input section of the Digital Audio Control Panel, you can 
specify the physical input connector (coaxial or optical) and display 
the current sampling rate for the 2-channel AES input on the selected 
Digital Audio Card.

Input Source

The AES input source default setting is Coaxial. If you want to use the 
optical connector instead of the coax connector for AES/EBU or 
S/PDIF input, choose Optical as the AES input source. In this case, the 
coax AES input source is deactivated. The AES 2-channel data path 
uses the optical connector on your Digital Audio Card, and the 
ADAT 8-channel input is disabled, as illustrated in Figure 2-3. 

Clock Source

The AES input always derives its clock from the corresponding input 
signal.

Sampling Rate

The Sampling Rate field displays the current measured sampling rate 
for the ADAT input signal.

To activate a new AES Input Source and/or Clock Source, and display 
the corresponding Sampling Rate, you must click the Apply button or 
the OK button at the bottom of the control panel (OK also closes 
the window).
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AES Out

In the AES output section of the Digital Audio Control Panel, you can 
specify the physical connector, clock source, sampling rate, and the 
data stream format (consumer or professional mode) for the AES 
2-channel output on the selected Digital Audio Card.

Output Destination

The AES output destination default setting is Coaxial. If you want to 
use an optical connector instead of a coax connector for AES/EBU or 
S/PDIF output, choose Optical as the AES output destination. In this 
case, the Coax AES output and the ADAT output data path are 
disabled, as illustrated in Figure 2-4. 

Clock Source

You can choose any of the following clock sources for the ADAT 
output:

• AES Input

• ADAT Input

• Internal 32 kHz clock 

• Internal 44.1 (oscillator)

• Internal 48 kHz (oscillator)

• Video Sync 44.1 kHz (derived from reference video sync source)

• Video Sync 48 kHz (derived from reference video sync source)

Use the Video Sync Source setting in the lower left corner of the 
control panel to specify whether the reference video clock is derived 
from the external video input on the Digital Audio Card or the internal 
video sync connection in your workstation. This setting is described in 
detail later in this chapter.
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Sampling Rate

If you choose AES input or ADAT input as the clock source, the 
Sampling Rate field displays the current measured sampling rate for 
the ADAT output signal. If you choose an internal oscillator or a 
reference video sync source as the clock source, the Sampling Rate 
field displays the nominal sample rate (32.00 kHz, 48.00 kHz, or 
44.10 kHz).

Mode

The mode setting allows you to select Consumer (IEC 958, S/PDIF) or 
Professional (AES3-1997) for the AES digital output stream. These 
two bitstream formats use different settings for some of the auxiliary 
(non audio) bits.

To activate a new Output Destination and/or Clock Source, display 
the corresponding Sampling Rate, and/or set a new Mode, you must 
click the Apply button or the OK button at the bottom of the control 
panel (OK also closes the window).
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Video Sync Source

The ADAT output signal and/or the AES output signal can derive 
their sampling clocks from a reference video clock. The Video Sync 
Source setting (at the lower left corner of the control panel) specifies 
whether the reference video clock is derived internally from one of the 
video inputs or outputs in your workstation, or externally from the 
reference video loop-through on the Digital Audio Card. 

You can choose either Internal Video Sync or External Video Sync for 
each Digital Audio Card installed in your workstation. However, for 
each Digital Audio Card, the ADAT and AES outputs must use the 
same reference video source (either internal video sync or external 
video sync). 

Internal Video Sync Master

When you use an internal video sync source, you must specify which 
of your workstation’s video inputs or outputs to use for the video 
timebase. You do this by clicking the Internal Video Sync tab at the 
top of the Digital Audio Control Panel to display the Internal Video 
Sync Master settings, as shown in the example in Figure 2-5 for a 
Silicon Graphics 540 with the Silicon Graphics serial digital video 
option installed. 

For a Silicon Graphics 320 or Silicon Graphics 540, you can choose any 
one of the Composite or S-Video inputs and outputs as your internal 
video sync source. For a Silicon Graphics 540 with the serial digital 
video option installed, you can also choose the Reference Video input 
or any one of the serial digital inputs and outputs as your internal 
video sync source. On a Silicon Graphics 540 with no video sync 
connection, these settings are grayed out. On a Silicon Graphics 540 
with no serial digital video option installed, these settings do not 
appear. On a Silicon Graphics 320, these settings are not available. 
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The Internal Video Sync Master settings are global for the system. You 
can select only one internal video sync master source. Each of the 
Digital Audio Cards installed in your system receives a reference 
video clock from the selected source. Figure 2-6 shows the relationship 
between the video sync source options.

Figure 2-5 Internal Video Sync Master Settings (Silicon Graphics 540 with 
serial digital video option installed)
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Figure 2-6 Video Sync Sources
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Bl ink Optical Outpu t Button

For information on this control panel button, see “Identifying Digital 
Audio Cards after Installation” in Chapter 1.

Configu re Wave Devices Button

For information on this control panel button, see “Configuring Wave 
Audio Devices” in Chapter 3.

Digita l Audio Meter Panel

You use the Digital Audio Meter Panel to monitor the audio signal 
levels on your Digital Audio Card(s).

1. Click the Silicon Graphics icon in the System Tray on the taskbar 
(near the clock).

The Silicon Graphics Control Panels menu appears, as shown in 
Figure 2-7.

Figure 2-7 Silicon Graphics Control Panels Menu
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2. Choose Digital Audio Meter Panel. 

The Digital Audio Meters Panel appears, as shown in the 
example in Figure 2-8, with two Digital Audio Cards installed.

You can also access the Digital Audio Meters Panel by choosing 
Start > Settings > Control Panel > SGI Digital Audio Meters.

0 dB always represents the peak absolute sample value (  for 
16-bit, for 20-bit, for 24-bit).

The digital audio software implements the reduced meter ranges 
by truncation. When the audio level drops below the minimum 
signal level in the meter range, no audio signal appears.

Figure 2-8 Digital Audio Meters Panel

3. Click File in the menu bar.

The File menu appears with two options, Digital Audio Control, 
which opens that control panel and Exit, which closes the Digital 
Audio Meters panel.

215

219 223
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4. Click Help in the menu bar.

The Help menu appears with two options, Contents, which 
displays the Silicon Graphics Audio/Video Help book and About, 
which displays the version number of the currently installed 
digital audio software.

5. Click Display in the menu bar.

The Digital Audio Meters Display menu appears, as shown in 
Figure 2-9.

In this menu, you can select a display format for the Digital 
Audio Meters Panel.

Figure 2-9 Digital Audio Meters Display Menu

Following is a description of each of these display formats.
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Keep Display In Foreground

This option displays the panel in front of all other windows. If you 
choose this option, the panel is always visible and is not blocked by 
your current sound application. This option is especially useful in 
conjunction with the Thumbnail Display option.

Increase Display Size

This option increases the size of the panel.

Decrease Display Size

This option decreases the size of the panel.

Thumbnail Display

This option displays a minimal panel with no text or labels. It is useful 
for monitoring the input and output signals.

Aquatic Color Scheme

This option displays the meters in a blue-green color.
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Rolling Wave

This option displays a sine wave rolling across the meters (eye candy).

Set Meter Range

This option displays the Set Meter Range popup menu. In this menu, 
you can select the meter range (in dB), as shown in Figure 2-10.

Figure 2-10 Set Meter Range Popup Menu
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Chapter 3

3. Configuring the Digital Audio Card

This chapter explains how to configure your Digital Audio Card. It 
shows you how to synchronize your card to external audio or video 
devices or to the internal subsystem in your Silicon Graphics 320 or 
Silicon Graphics 540 workstation. You will also learn how to configure 
the logical WAVE audio devices (stereo, mono, and so on) that 
correspond to the physical inputs and outputs on the Digital Audio 
Card. Windows NT applications use these logical devices to record 
and playback audio through the card.

Synchronizing Digital Audio Cards for Audio/Video
Soundtrack Production

Depending on your studio configuration, you may want to 
synchronize your Digital Audio Card(s) to an external master clock 
source or your system’s internal video subsystem. This section 
describes four example studio configurations and explains how to 
synchronize your Digital Audio Card(s) in each configuration.
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Example 1: Synchronizing One Digital Audio Card and a
VCR using a Silicon Graphics 320

This example shows you how to configure audio synchronization 
with a VCR using a Silicon Graphics 320 visual workstation with one 
Digital Audio Card installed. In this example, the workstation’s 
composite video input provides a master clock source for the Digital 
Audio Card through the system’s internal sync connection. The Digital 
Audio Card’s AES digital output then provides a master clock source 
for an external digital mixing console. The Digital Audio Card’s AES 
output clock is synchronized with the composite video signal from the 
VCR. To set up this configuration, follow the step-by-step procedures 
that appear on the following pages. 

Figure 3-1 Digital Audio Card/VCR Sync - Silicon Graphics 320
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Setting Up the Configuration

1. Connect the Digital Audio Card’s ADAT optical  input and output 
cables to a small format digital mixing console.

The digital mixing console provides Analog-to-Digital and 
Digital-to-Analog conversion and outboard audio processing.

2. Connect the Digital Audio Card’s AES/EBU connectors on the 
breakout cable to the 2-channel input on the digital mixing 
console.

3. Connect the composite video output from the VCR to the 
composite video input on the workstation.

4. Capture stereo audio from the VCR through the Digital Audio 
Card using the mixing console.

The mixing console digitizes stereo analog audio and transmits 
the digitized audio to the Digital Audio Card through the ADAT 
optical cable or the AES/EBU connectors on the breakout cable.

5. Connect the composite video output from the workstation to an 
external video monitor to preview the video content.

6. Click the Silicon Graphics icon on the right side of the taskbar.

The Silicon Graphics Control Panels Menu appears, as shown in 
Figure 1-7.

7. Click Digital Audio Control Panel.

The Silicon Graphics Digital Audio Control Panel appears.
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8. Set up the Digital Audio Control Panel, as shown in the example 
in Figure 3-2.

Note: Video sync provides the clock source for both AES/EBU 
output and ADAT output. For this configuration, you 
select Internal Video Sync as the Video Sync Source (in 
the lower left corner of the Digital Audio Control Panel), 
as shown in Figure 3-2.

Figure 3-2 Digital Audio Card/VCR Sync - Control Panel Settings

9. Select the Internal Video Sync tab in the Silicon Graphics Digital 
Audio Control Panel.

The Internal Video Sync Master settings appear, as shown in 
Figure 3-3 for a Silicon Graphics 320.

In this window, you can specify the desired video input or output 
that the system uses as the clock source for Internal Video Sync.
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10. Select Composite In as the Internal Sync Source, as shown in 
Figure 3-3.

11. Select the OK button in the Silicon Graphics Digital Audio 
Control Panel.

Figure 3-3 Digital Audio Card/VCR Sync - Internal Sync Source Settings 
(Silicon Graphics 320)
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Example 2: Synchronizing Two Digital Audio Cards and
a Professional S-VHS VTR using a Silicon Graphics 320

This example shows you how to configure audio synchronization 
with a professional S-VHS video tape recorder using a Silicon 
Graphics 320 with two Digital Audio Cards installed. Three studio 
synchronization schemes are provided. To set up these configurations, 
use the step-by-step procedures that appear on the following pages.

Figure 3-4 Two Digital Audio Cards/S-VHS Sync - Silicon Graphics 320
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Setting Up the Basic Configuration

1. Connect the ADAT optical  inputs and outputs on the two Digital 
Audio Cards to outboard equipment such as a digital mixing 
console or a pair of modular digital multitrack (MDM) tape 
recorders.

2. Connect an S-video output from the VTR to the S-video input on 
the workstation.

Studio Synchronization Scheme 1: Provide External Video
Reference Signal to Digital Audio Cards

In this scheme, the Digital Audio Cards use a video reference signal 
from the VTR as the master clock source. The VTR transfers the video 
reference signal to a video sync distribution amplifier, which transfers 
the signal to each of the Digital Audio Card’s external video reference 
inputs (on the breakout cable), as shown in Figure 3-4.

1. Connect a composite video output from the VTR to a video 
distribution amplifier. 

2. Connect the video reference signal outputs from the video sync 
distribution amplifier to the video reference inputs on each of the 
Digital Audio Cards.

3. Terminate the unused video loop-through connectors on each of 
the Digital Audio Cards using 75 ohm terminators.

4. Connect a video reference signal output (or word clock) from the 
video sync distribution amplifier to the digital mixing console.

5. Click the Silicon Graphics icon on the right side of the taskbar.

The Silicon Graphics Control Panels Menu appears.

6. Click Digital Audio Control Panel.

The Silicon Graphics Digital Audio Control Panel appears.

7. Click the Card #1 tab.

The Card #1 Control Panel appears.
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8. Set up the Card #1 Control Panel, as shown in the example in 
Figure 3-5.

Figure 3-5 Two Digital Audio Cards/S-VHS Sync - Card #1 Control Panel 
Settings

9. Click the Card #2 tab.

The Card #2 Control Panel appears with Internal Video Sync 
grayed out under Video Sync Source, as shown in Figure 3-6. 
There is a single internal video sync connector on the Silicon 
Graphics 320 motherboard that is connected to Card #1 in this 
example.
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10. Click the OK button in the Digital Audio Control Panel.

Note: If you connect any outboard digital audio equipment to 
the Digital Audio Cards, (for example, an external digital 
mixing console or a digital audio multitrack tape 
recorder) you should also synchronize this equipment to 
a common timebase (video reference, word clock, and so 
on) derived from the master video source (professional 
S-VHS recorder).

Figure 3-6 Two Digital Audio Cards/S-VHS Sync - Card #2 Control Panel 
Settings 
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Studio Synchronization Scheme 2: Loop Video Reference
Signal From Card to Card

This alternate scheme shows you how to synchronize two Digital 
Audio Cards to a video reference signal by looping the signal from one 
card to the other card. This scheme is similar to scheme 1 but a video 
sync distribution amplifier is not used to transfer parallel video 
reference signals to the two cards.

1. Loop the composite video output from the VTR through Digital 
Audio Card #1 to Digital Audio Card #2 by connecting a short 
coax cable between the video reference connectors on the two 
cards. 

2. Terminate the unused loop-through connector on the second card 
using a 75 ohm terminator.

3. Use the same Digital Audio Control Panel settings as in Studio 
Synchronization Scheme 1.

4. Click the OK button in the Digital Audio Control Panel.

Studio Synchronization Scheme 3: Provide AES11 Reference
Clocks

This alternate scheme shows you how to synchronize two Digital 
Audio Cards by connecting AES11 reference inputs to each of the cards 
instead of video reference inputs. This example assumes you have a 
house sync generator that can generate synchronized AES11 reference 
outputs from the professional S-VHS recorder’s video reference 
output.

1. Connect the composite video output from a VTR to a house sync 
generator.

2. Connect the AES sync outputs from the house sync generator to 
the AES input connectors on each breakout cable connected to 
each Digital Audio Card. 
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3. Set up the Digital Audio Control Panel, as shown in Figure 3-7.

4. Click the OK button in the Digital Audio Control Panel.

Figure 3-7 Studio Synchronization Scheme 3 - Control Panel Settings
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Example 3: Synchronizing Two Digital Audio Cards and
a Digital VTR using a Silicon Graphics 320

This example shows you how to configure a Silicon Graphics 320 for 
audio-for-video post production using a high-end digital VTR for 
source and layback to tape. To set up this configuration, use the 
step-by-step procedures that appear on the following pages.

Figure 3-8 Two Digital Audio Cards/Digital VTR Sync-Silicon Graphics 320
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Setting Up the Configuration

1. Connect the ADAT optical inputs and outputs on the two Digital 
Audio Cards to an outboard digital mixing console.

2. Connect the AES inputs and outputs on the two Digital Audio 
Cards to a professional digital VTR to enable four channel 
AES/EBU audio transfers between the VTR and the workstation.

3. Connect the AES inputs and outputs for channels one and two on 
the VTR to Digital Audio Card #1.

4. Connect the AES inputs and outputs for channels three and four 
on the VTR to Digital Audio Card #2.

5. Connect a composite video output from the VTR to an analog 
video input on the Silicon Graphics 320 to synchronize video 
capture with the soundtrack.

You can preview video content using an external NTSC or PAL 
video monitor that is connected to an analog video output on the 
workstation.

6. Connect the video reference signals from the house sync 
generator to provide master clock sources for the VTR and for the 
Digital Audio Cards.

7. Connect a video reference signal or word clock signal from the 
house sync generator to provide a master clock source for the 
digital mixing console.

All the studio devices are now synchronized to a house sync 
generator.

8. Place a 75 ohm terminator on the unused video loop through 
connector on each of the two Digital Audio Cards.

9. Click the Silicon Graphics logo on the right side of the taskbar.

The Silicon Graphics Control Panels Menu appears.

10. Click Digital Audio Control Panel.

The Silicon Graphics Digital Audio Control Panel appears.
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11. Set up Digital Audio Card #1 and Digital Audio Card # 2 as shown 
in Figure 3-9.

12. Click the OK button in the Silicon Graphics Digital Audio 
Control Panel.

Figure 3-9 Two Digital Audio Cards/Digital VTR Sync - Card # 1 and 
Card #2 Control Panel Settings
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Example 4: Synchronizing Two Digital Audio Cards with
the Silicon Graphics 540 Serial Digital Video Option

This example shows you how to configure a Silicon Graphics 540 for 
digital audio/video production. To set up this configuration, use the 
step-by-step procedures on the following pages.

Figure 3-10 Two Digital Audio Cards/Serial Digital Video Option Sync - 
Silicon Graphics 540
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Setting Up the Configuration

1. Configure your workstation with the Silicon Graphics serial 
digital video option for serial digital video (SDI) input and 
output, and with two Digital Audio Cards for multichannel 
digital audio input and output.

2. Connect two digital VTRs to SDI input/outputs 1 and 2 
respectively, on the serial digital video option.

3. Connect the AES digital audio inputs and outputs for the audio 
channels 1 and 2 on the two VTRs to AES inputs and outputs on 
the two Digital Audio Cards.

This allows the capture and playback of 2-channel digital audio, 
which is synchronized with the serial digital video option.

4. Connect the optical connectors on Digital Audio Card #1 to a 
consumer DAT machine to transfer 2-channel S/PDIF digital 
audio data to/from the DAT machine.

5. Connect the optical connectors on Digital Audio Card #2 to a 
small format digital mixing console to transfer 8-channel digital 
audio to/from the mixing console.

6. Connect each of the VTRs to a digital reference signal from the 
sync generator.

7. Connect the mixing console to a word clock.

8. Connect a digital reference signal to the video reference input on 
the serial digital video option.

This provides the master clock for the audio and video devices 
inside the workstation.

All the studio devices are now synchronized to a house sync 
generator. 

Each Digital Audio Card is synchronized with the serial digital 
video option’s video sync input using your workstation’s 
onboard internal video sync capture circuitry.

9. Click the Silicon Graphics icon on the right side of the taskbar.

The Silicon Graphics Control Panels Menu appears.
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10. Click Digital Audio Control Panel.

The Silicon Graphics Digital Audio Control Panel appears.

11. Set up the Digital Audio Control Panel as shown in the examples 
in Figures 3-11 through 3-14.

Figure 3-11 Two Digital Audio Cards/Serial Digital Video Option Sync - 
Card #1 Control Panel Settings for AES/EBU Transfers to/from 
VTR
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Figure 3-12 Two Digital Audio Cards/Serial Digital Video Option Sync - 
Card #1 Control Panel Settings for S/PDIF Transfers to/from 
DAT Recorder
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Figure 3-13 Two Digital Audio Cards/Serial Digital Video Option Sync - 
Card #2 Control Panel Settings for AES/EBU Transfers to/from 
VTR
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Figure 3-14 Two Digital Audio Cards/Serial Digital Video Option Sync - 
Internal Video Sync Setting Using Sync Input on Serial Digital 
Video Option

12. Click the OK button in the Silicon Graphics Digital Audio 
Control Panel.
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Configuring Wave Audio Devices

Typically, Windows NT audio applications use stereo or mono WAVE 
input and output devices for recording and playback. Some audio 
editing applications allow a user to open multiple mono or stereo 
WAVE devices to enable multichannel audio recording and playback. 
Your Digital Audio Card uses logical WAVE devices to interface audio 
applications with the physical channels on the ADAT and AES/EBU 
inputs and outputs. For example, you can configure the Digital Audio 
driver to allow audio applications to address each of the eight 
individual ADAT input channels through eight separate logical mono 
WAVE input devices. For the ADAT input and output, you can also 
configure the driver to provide 8-channel logical WAVE devices. By 
default, the Digital Audio Card allows an application to address the 
eight channels through four logical stereo input devices. In addition, 
you can configure the driver to provide mono WAVE input devices for 
the AES and ADAT input and output ports. These configurations are 
shown in Figure 3-15.

Note: Currently, only a few audio applications support 
8-channel logical WAVE devices.

Figure 3-15 Configuring WAVE Audio Devices
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You can use logical WAVE devices independently, except in the 
following cases:

• You cannot use audio devices simultaneously if they share any 
hardware channels.

• You can only set certain characteristics, including sampling rate 
and sync source on a hardware port, for example, ADAT input, 
AES input, ADAT output, or AES output. 

• You cannot set these parameters differently for two WAVE 
devices that share the same physical hardware interface.

Changing Logical WAVE Devices

You can change the Digital Audio Card’s logical WAVE devices as 
follows:

1. Click the Configure Wave Devices button in the Digital Audio 
Control Panel.

The Configure Wave Devices pop-up menu appears, as shown in 
the example in Figure 3-16.

2. Select the desired devices. 

3. Click the OK button.

4. Activate your new WAVE configuration by restarting your 
system, or by deactivating and then reactivating the Digital Audio 
Card driver in the Windows NT Devices Control Panel.

Figure 3-16 Configure Wave Devices Pop-Up Menu
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Start Recording/Playing All Active Channels

Currently, Windows NT multimedia does not support sample 
accurate synchronization across multiple logical WAVE devices. This 
causes a problem when an application attempts to simultaneously 
begin audio recording or playback using several logical stereo or 
mono devices, for example, simultaneous record/playback using all 
eight ADAT interface channels. However, you can avoid this problem 
using an internal workaround in the digital audio driver by following 
these steps: 

1. Click Start recording all active channels on first record 
command in the Configure Wave Devices pop-up menu. 

The Digital Audio driver starts filling all queued input buffers for 
a given physical device (ADAT or AES/EBU input port) when it 
receives the first start record command for any corresponding 
logical mono or stereo WAVE output device. 

2. Click Start playing all active channels on last play command in 
the Configure Wave Devices pop-up menu. 

The Digital Audio driver starts playing all queued output buffers 
for a given physical device when it receives the last play 
command for any corresponding logical mono or stereo WAVE 
device.

Note: For example, this mode is useful if you are capturing 
audio from a multitrack tape recorder using the ADAT 
input port, or transferring audio back to the multitrack 
tape recorder using the ADAT output port.
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Appendix A

A. Digital Audio Card Specifications

General Specifications

• PCI 32 bit option board - half-size

• Supports universal PCI voltage specifications 

• System expansion by addition of multiple cards

• Supports standard Windows NT WAVE audio interface 

• UST/MSC digital media synchronization support for 
applications utilizing the Silicon Graphics Digital Media SDK 

• Locks to audio reference via external AES11 input

• Locks to video via external reference or internal video sync. 
Accepts video reference input, generates AES11-1992 grade 2 
(10 ppm) clocks 
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Sample Rates

• Generalized support of sample rates including the following 
rates: 

• 32.00 kHz (AES only)

• 44.10 kHz including high quality VCXO jitter attenuation 

• 48.00 kHz including high quality VCXO jitter attenuation

Master Timebases

• Internal crystal oscillators 

• Video reference (internal or external) 

• AES11 input 

• ADAT optical input 

Video Reference Loop Through

• 75 ohm BNC connectors 

• Black Burst NTSC or PAL 

Coaxial Digital Audio Input

• AES-3id 75 ohm BNC connector 

• AES11-1992 synchronization input (for audio clock rates) 

• AES3-1997 professional 2-channel 24-bit digital 

• Compatible with IEC958, S/PDIF consumer 2-channel digital 
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Coaxial Digital Audio Output

• AES-3id 75 ohm BNC connector 

• AES11-1992 synchronization output 

• AES3-1997 professional 2-channel 24-bit digital 

• Compatible with IEC958, S/PDIF consumer 2-channel digital 

ADAT Optical Digital Input

• 12.8 Mbps EIAJ RCZ-6901 fiber optic connector, PCI I/O panel 

• 8-channel, 24-bit  

• Compatible with IEC958, S/PDIF consumer 2-channel digital 

ADAT Optical Digital Output

• 12.8 Mbps EIAJ RCZ-6901 fiber optic connector, PCI I/O panel 

• 8-channel, 24-bit  

• Compatible with IEC958, S/PDIF consumer 2-channel digital 
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Appendix B

B. Supported WAVE Audio Sample Formats

20/24-bit PCM data stored using 4 bytes per sample

• Sample value left-justified within 4-byte word 

• Low-order bits are zero-filled

• Two’s-complement signed values: sample range is  to 

To use this format, the application should specify the following fields 
in the WAVEFORMATEX structure:

• wBitsPerSample = 20 or 24

• nBlockAlign = 4*nChannels

• nChannels = 1 if mono WAVE device, 2 if stereo WAVE 
device, 8 if 8-channel WAVE device

20/24-bit PCM data stored using 3 bytes per sample

• Low order bits are zero-filled in the case of 20-bit data 

• Two’s-complement signed values: sample range is  to 

To use this format, the application should specify the following fields 
in the WAVEFORMATEX structure:

• wBitsPerSample = 20 or 24

• nBlockAlign = 3*nChannels

• nChannels = 1 if mono WAVE device, 2 if stereo WAVE 
device, 8 if 8-channel WAVE device

2–
31

2
31

1–

2–
23

2
23

1–
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16-bit data

• Two’s-complement signed values: sample range is  to 

8-bit data

• Conforms to Microsoft WAVE convention of presenting 8-bit 
PCM data using unsigned integer values

• Sample range is 0 to 255

2–
15

2
15

1–
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Glossary

ADAT optical interface

An interface that provides a unidirectional point-to-point connection 
of eight tracks of 24-bit digital audio, with subcodes, at professional 
sampling rates, on a single consumer-grade optical fiber. Typically, 
this interface is used for data connections between multiple ADAT 
tape decks, for bouncing tracks between the decks.

AES3

The AES-1992 digital audio data transmission format specification. 
This specification is also referred to as AES/EBU. See also ANSI 
S4.4-1992 and IEC958, Audio Engineering Society, Inc., Vol. 40, No. 3, 
1992, New York, NY 10165. For more information on this specification 
on the Web, see http://www.aes.org.publications/

AES3-3id

A document that describes the implementation of AES-1992 (see 
above) using 75 ohm coaxial cable with 1 volt peak-to peak signal 
levels. For more information on this document on the Web, see 
http://www.aes.org.publications/

PCI

Peripheral Component Interconnect - a bus specification. The PCI bus 
is a high-performance local bus used to connect computer peripherals 
to memory and a microprocessor. A wide range of vendors 
manufacture devices that plug into a PCI bus.
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S/PDIF

A serial interconnect standard for consumer digital audio equipment. 
This interface can transfer stereo or single channel audio content at 
sample resolutions up to 20 bits (or 24 bits using an extension to the 
specification) and sample rates of 32 kHz, 44.1 kHz, and 48 kHz. 
Physical connectors are typically RCA jacks or optical connectors. For 
a complete description of S/PDIF, see the IEC 958 specification.
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Index

A

ADAT In,  23
ADAT input signal path,  24
ADAT Optical interface connectors,  1, 18

and dust contamination,  2, 4, 18
ADAT Out,  25 - 26
ADAT output signal path,  26
AES In,  27
AES input signal path,  24
AES Out,  28
AES output signal path,  26
AES/EBU connectors,  19
Apply button

ADAT In,  24
ADAT Out,  26
AES In,  27
AES Out,  29

Aquatic Color Scheme,  36
Audio tab,  10
Audio/Video soundtrack production,  39 - 54
B

balun transformers,  19
Blink Optical Output button,  14
breakout cable,  1

connecting to Digital Audio Card,  16 - 17
connecting to external devices,  19

Browse button,  7

C

cables
breakout,  1, 16 - 17, 19
connecting to Digital Audio Card,  16 - 19
fiber optic,  1
video sync,  1

Clock Source
ADAT In,  23
ADAT Out,  25
AES In,  27
AES Out,  28

Coaxial
AES In,  27
AES Out,  28

Configure Wave Devices button,  60
Consumer mode,  28, 29
Control Panel, using,  21 - 33
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D

DB15 connector,  1, 17
Decrease Display Size,  36
Digital Audio Card

components,  1
configuring,  39 - 61
connecting fiber optic cables to,  18
identifying after installation,  14 - 15
installing in Silicon Graphics 320,  2 - 3
installing in Silicon Graphics 540,  4
setting up,  21 - 33
software

installation,  6 - 7
verifying,  9 - 13

upgrading,  8
synchronizing,  39 - 54

Digital Audio Card driver,  8
Digital Audio Control Panel

identifying Digital Audio Card,  14
selecting display formats,  34 - 36
setting up Digital Audio Card,  21 - 33
synchronizing

Digital Audio Card/VCR,  42 - 43
studio scheme,  49
two Digital Audio Cards/Digital VTR,  52
two Digital Audio Cards/S-VHS,  46 - 47
two Digital Audio Cards/serial digital 

video option,  55 - 58
using,  21 - 33
verifying Digital Audio Card installation,  12

Digital Audio Installation CD,  6
Digital Audio Meters Display menu,  35
Digital Audio Meters Panel

monitoring audio levels signal,  33 - 35
verifying software installation,  13

E

external clocking,  18
External Video Sync,  30, 32

F

fiber optic cables,  1
connecting,  18

H

Help menu,  23, 35

I

Increase Display Size,  36
Input Source

ADAT In,  23, 24
AES In,  24, 27

Internal Video Sync
in Digital Audio Control Panel,  22
Master settings,  30 - 32, 42 - 43

K

Keep Display in Foreground,  36
kernel level driver,  6

M

mode,  29
Multimedia Properties Control Panel

displayed,  9
installing software,  7
upgrading software,  8
verifying software installation,  9
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O

Optical
ADAT In,  23
ADAT Out,  25
AES In,  27
AES Out,  28

Output Destination
ADAT Out,  25
AES Out,  28

P

PCI card,  2, 5
Professional mode,  28, 29

R

reference video clock
ADAT Out,  25, 30
AES Out,  28, 30

reference video sync source
ADAT Out,  25 - 26
AES Out,  28 - 29

Rolling Wave,  37

S

Sampling Rate
ADAT In,  24
ADAT Out,  26
AES In,  27
AES Out,  29

serial digital video option,  30, 53 - 58
Set Meter Range,  37
SGI Sound Playback,  10
SGI Sound Record,  11

Silicon Graphics 320
installing Digital Audio Card in,  2 - 3
synchronizing

one Digital Audio Card and VCR,  40 - 43
two Digital Audio Cards and Digital VTR,  

50 - 51
two Digital Audio Cards and S-VHS VTR,  

44 - 49
Silicon Graphics 540

installing Digital Audio Card in,  4
synchronizing,

two Digital Audio Cards and serial digital 
video option,  53 - 54

Silicon Graphics Control Panels menu,  12, 21, 
33

software
installation,  6 - 7

verifying,  9 - 13
upgrading,  8

soundtrack production
and synchronizing Digital Audio Card(s),  

39 - 54
S/PDIF

input,  23, 27
output,  25, 28

start playing all active channels,  61
start recording all active channels,  61
studio synchronization,  44 - 49
synchronizing

and breakout cable,  16
Digital Audio Card(s),  39 - 54
Silicon Graphics 320,  2, 40 - 52
Silicon Graphics 540,  4, 53 - 54

T

Thumbnail Display,  36
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U

user level driver,  6

V

video sync cable,  1
connecting

in Silicon Graphics 320,  2 - 3
in Silicon Graphics 540,  4 - 5

Video Sync Source
ADAT Out,  25, 30 - 32
AES Out,  28, 30 - 32

W

WAVE Audio devices
changing,  60
configuring,  59 - 60
playback,  10, 11
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